
TEMPLOT2 version 2.11a KEYBOARD SHORTCUTS -DRAWING PAD MENUS  

 For laptop users there are some alternatives to the number-pad shortcuts : 

 ADD key (zoom in) is also on SHIFT+CTRL-EQUALS (=) 

 SUBTRACT key (zoom out) is also on SHIFT+CTRL-MINUS (-) 

 MULTIPLY key (peg onto notch) is also on SHIFT+CTRL-QUOTE (') 

 DIVIDE key (notch under peg) is also on SHIFT+CTRL-SLASH (/) 

 

KEYBOARD FUNCTION DETAILS 

HOME key  HIDE THE CONTROL TEMPLATE (toggle)  hide the control template to show background items 
only on the pad (toggle HOME key to show again, or 
press F12 to reset) 

ENTER key  HIDE THE CONTROL TEMPLATE (toggle)  

Same operation as the HOME Key above 

hide the control template to show background items 
only on the pad (toggle ENTER key to show again, or 
press F12 to reset) 

END key  
HIDE TEMPLATE NAME LABELS (toggle)  hide all the template name labels to show background 

items only on the pad (toggle END key to show all 
name labels again) 

CTRL + ENTER key 
HIDE TEMPLATE NAME LABELS (toggle)  

Same operation as the END Key above 

hide all the template name labels to show background 
items only on the pad (toggle CTRL + ENTER key to 
show all name labels again) 

CTRL + HOME key  HIDE ALL BACKGROUND TEMPLATES (toggle)  hide all background templates (toggle CTRL + HOME 
key to show all the background templates again) 

SHIFT + HOME key  HIDE ALL BACKGROUND SHAPES (toggle)  hide all background shapes (toggle CTRL + HOME 
key to show all the background shapes again) 

SHIFT + CTRL + HOME key  HIDE ALL GROUPED TEMPLATES (toggle)  hide all grouped templates (toggle SHIFT + CTRL + 
HOME key to show all the grouped templates again) 

SPACE-BAR key  PAD VIEW TO FIT THE CONTROL TEMPLATE  zoom the pad view to fit the control template only  

BACK-SPACE key  REPEAT LAST ACTION  repeat the most recently used mouse action  

   

CTRL + A  GROUP SELECT ALL  select all stored templates as members of a group  

CTRL + B  STORAGE BOX  show the Storage Box window  

CTRL + C  METRIC/SCALE CALCULATOR  show the metric/scale calculator  

CTRL + D  RE-DO CHANGES  cycle the roll-back register forwards (cancel CTRL + U, 
UNDO) split exit track from the control turnout  

CTRL + E  MAKE SEPARATE EXIT TRACK  template to form a separate plain-track template  

CTRL + F  MAKE SEPARATE APPROACH TRACK  
split approach track from the control turnout template 
to form a separate plain-track template  

CTRL + G MAKE SPLIT AT PEG split the control plain-track template into two 

separate templates 

CTRL + H SWAP HAND swap the control template to the opposite hand 

(i.e. flip entire template, see also CTRL + X) 

CTRL + I INSERT TURNOUT IN PLAIN TRACK convert the control plain track template to a 

turnout template on the same alignment 

CTRL + J JOTTER (toggle) show or hide the jotter window for your jottings 

CTRL + K CONVERT TURNOUT TO HALFDIAMOND convert the control turnout template to a half-diamond 
template on the same alignment 

CTRL + L CONVERT TO PLAIN TRACK convert the control turnout template to a plain 

track template on the same alignment 

CTRL + M MINT FROM THE CONTROL restore the control template to mint condition 

CTRL + N SWAP TEMPLATE END-FOR-END 

(Also used as SWAP FACING - TRAILING) 

swap the control template end-for-end on the 

same alignment (convert a facing turnout to or 

from a trailing turnout) 

CTRL + O OMIT RAILS & JOINT MARKS Opens menu to allow the removal of individual rails 
and joint marks, to select tick or un-tick boxes as 
appropriate 

CTRL + P PARK THE CONTROL # 1 park a copy of the control template in parking bay # 1 
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CTRL + Q QUICK SET... show the quick-set window to quickly set a 

new mint template 

CTRL + R RETRIEVE PARKED # 1 retrieve the control template from the copy in 

parking bay # 1 

CTRL + S BACKGROUND SHAPES show the Background Shapes window to add, 

modify or delete shapes, labels and scanned images 

CTRL + T CONVERT HALF-DIAMOND TO TURNOUT convert the control half-diamond template to a 

turnout template on the same alignment 

CTRL + U UNDO CHANGES cycle the roll-back register backwards (cancel 

CTRL + D, RE-DO) 

CTRL + V STORE & BACKGROUND add a copy of the control template to the 

storage box and copy it to the pad background 

CTRL + W INSERT HALF-DIAMOND IN PLAIN TRACK convert the control plain track template to a 

half-diamond template on the same alignment 

CTRL + X INVERT HANDING swap the hand of the control template and invert the 
curving (i.e swap TS and MS with the main road 
curving-line preserved, see also CTRL + H) 

CTRL + Y GROUP SELECT NONE 

(also CANCEL GROUPING) 

de-select all stored templates from a group 

also cancels all grouped templates on the trackpad 

CTRL + Z UNDO DELETED TEMPLATE restores the most recently deleted stored template back 
to the storage box and background drawing. 

   

CTRL + DELETE CLEAR ALL TEMPLATES clear (delete) all stored templates and the 

background drawing 

   

The following CTRL+number 

Shortcuts use the number keys 

on the main keyboard only 

(not the key pad numbers) 

  

CTRL + 1 PEG ON RAIL-JOINT set the fixing peg at the toe rail-joint for 

turnouts, or the joint end for plain track 

CTRL + 2 PEG ON TP (toggle) set the fixing peg at the toe-point (switch blade 

tips) (repeat to toggle alignment to main-road 

or turnout-road) 

CTRL + 3 PEG ON DP (toggle) set the fixing peg at the deflection-point (repeat 

to toggle alignment to main-road or turnout-road) 

CTRL + 4 PEG ON FP (toggle) set the fixing peg at the fine-point (gauge-line 

intersection) (repeat to toggle alignment to 

main-road or turnout-road) 

CTRL + 5 PEG ON TXP set the fixing peg at the turnout-side crossover 

mid-point 

CTRL + 6 PEG ON TVJP set the fixing peg at the turnout-side vee joint 

(vee splice rail end) 

CTRL + 7 PEG ON MXP set the fixing peg at the main-side crossover mid-point 

CTRL + 8 PEG ON MVJP set the fixing peg at the main-side vee joint 

(vee point rail end) 

CTRL + 9 PEG ON LENGTH set the fixing peg at the full template length of the 
main-road side only, irrespective of length of  rails on 
the turnout side 

CTRL + 0 RESET PEG ONTO TEMPLATE DATUM reset the fixing peg on the template datum 

CTRL + END PEG ON RAIL JOINTS (repeating) set the fixing peg on plain-track rail joints, which 
includes incrementing to each joint along a track panel 
length 

   

F1 HELP BUTTONS AND BARS open help texts (where available) 

F2 INFO (toggle) toggle the information panel on or off, for the control 
template only 
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F3 or F4 ADJUST PLAIN-TRACK LENGTH MOUSE ACTION adjusts the length of a plaintrack 
template 

F3 ADJUST TURNOUT APPROACH LENGTH MOUSE ACTION adjusts the length of approach track 
for a turnout template and modifies the overall length 
accordingly 

F4 ADJUST OVERALL TURNOUT 

LENGTH 

MOUSE ACTION adjusts the overall length of 

a turnout template, adding exit track accordingly 

F5 ADJUST TURNOUT SIZE MOUSE ACTION adjusts the turnout size 

(switch size and V-crossing angle) 

F6 ADJUST CURVING MOUSE ACTION adjusts the curving-line radius in 
the main road 

F7 SHIFT POSITION MOUSE ACTION moves the template across 

the pad 

F8 ROTATE AROUND PEG MOUSE ACTION rotates the template around 

its fixing peg 

F9 ADJUST 'V' CROSSING ANGLE MOUSE ACTION adjusts the V-crossing angle 

F10 ADJUST 'K' CROSSING ANGLE MOUSE ACTION adjusts the K-crossing angle 

F11 PRINT THE CONTROL TEMPLATE print the control template pages only (including 

any background templates which they contain) 

F12 REDRAW + SHOW THE CONTROL 

Also RESET MOUSE RESPONSE 

reset and re-draw template; cancel mouse actions 

sets mouse action response rate to NORMAL 

   

CTRL + F1 or 1 key SPOT ZOOM AND LOCK MOUSE ACTION zooms on the spot (pad 

remains on existing centre) 

CTRL + F2 or 2 key SHOW ZOOM & PAN MENU Brings up the zoom and panning controls menu 

CTRL + F3 or 3 key ADJUST BLANKING LENGTH MOUSE ACTION blanks off part of the 

control template (from the Ctrl-0 datum end) 

this function is used for turnouts and diamonds 

CTRL + F4 or 4 key ROLL RAILS AND SLEEPERS MOUSE ACTION rolls the rail lengths along 

the control plain-track template (moves rail joints) 

CTRL + F5 or 5 key ORBIT RADIAL CENTRE MOUSE ACTION orbits the radial centre 

(swings the control template along the curving line) 

(previously called SWING) 

CTRL + F6 or 6 key SNAKE THROUGH PEG MOUSE ACTION slides the template through 

the peg position (curving-line is fixed, see also 

SHIFT + F9 SLIDE THROUGH PEG) 

CTRL + F7 or 7 key ADJUST SLEW AMOUNT MOUSE ACTION adjusts the amount of sideways 
slew 

CTRL + F8 or 8 key MOVE PEG MOUSE ACTION moves the fixing peg within 

the control template 

CTRL + F9 or 9 key ROAM ALONG LENGTH MOUSE ACTION moves the position of the 

turnout within the control template (adjust 

approach and exit track lengths equally) 

(previously called MAINTAIN LENGTH) 

CTRL + F10 or 0 key SWELL CURVING RADIUS MOUSE ACTION swells (bulges) the main-road 

radius for the control template between fixed ends 

CTRL + F11 PRINT ENTIRE PAD print the entire pad in pages including all 

background templates 

CTRL + F12 ADJUST TURNOUT-ROAD EXIT Adjusts the length of the turnout-road exit rails 

(this allows the TS exit rails to be made longer than the 
MS exit rails if required or can adjust turnout side 'Vee' 
rail independently ) 

   

SHIFT + F1 MAKE DIAMOND-CROSSING duplicate the control half-diamond and adjust it 

to form a diamond-crossing 

SHIFT + F2 MAKE SIMPLE CROSSOVER duplicate the control turnout and adjust it to 

form a double-track crossover 
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SHIFT + F3 MAKE DOUBLE-TRACK TS create plain track on the Turnout-Side of the control 
template for double-track with the track centres spaced 
at the dimension of the data entry of the adjacent track 
centres information for the control template 

SHIFT + F4 MAKE DOUBLE-TRACK MS create plain track on the Main-Side for of the 

control template for double-track with the track centres 
spaced at the dimension of the data entry of the 
adjacent track centres information for the control 
template 

SHIFT + F5 CALIBRATE PRINTER perform the printer calibration process 

SHIFT + F6 ROTATE GROUP 180 DEGS rotate the selected group of templates through 

180 degs around the notch 

SHIFT + F7 CYCLE NOTCH cycle the pegging notch through its recent 

locations 

SHIFT + F8 ROTATE THE CONTROL 180 DEGS rotate the control template through 180 degrees around 
its fixing peg 

SHIFT + F9 SLIDE THROUGH PEG MOUSE ACTION slides the template through the peg 
position in either direction (the curving-line slides, see 
also CTRL + F6 SNAKE) 

SHIFT + F10 SHOVE TIMBERS show the shove-timbers controls (menu) 

SHIFT + F11 ADJUST 'V' CROSSING ENTRY STRAIGHT MOUSE ACTION adjusts the turnout crossing entry 
straight 

SHIFT + F12 ADJUST GAUNT TURNOUT OFFSET MOUSE ACTION adjusts the offset of a gaunt turnout 

   

SHIFT+CTRL + F1 1st TRANSITION RADIUS mouse actions apply to 1st transition radius 

SHIFT+CTRL + F2 2nd TRANSITION RADIUS mouse actions apply to 2nd transition radius 

SHIFT+CTRL + F3 ADJUST TRANSITION START MOUSE ACTION adjusts the transition zone 

start point, this being the point marked by the straight 
line at the back of the indicator arrow 

SHIFT+CTRL + F4 ADJUST TRANSITION LENGTH MOUSE ACTION adjusts the length of the 

transition zone 

SHIFT+CTRL + F5 ADJUST SLEWING START MOUSE ACTION adjusts the slewing zone start point 

SHIFT+CTRL + F6 ADJUST SLEWING LENGTH MOUSE ACTION adjusts the length of the 

slewing zone 

SHIFT+CTRL + F7 SHIFT GROUP MOUSE ACTION shifts the selected group of 

templates across the pad 

SHIFT+CTRL + F8 ROTATE GROUP MOUSE ACTION rotates the selected group of 

templates around the notch 

SHIFT+CTRL + F9 

or . Key (full stop, period key) 

ADJUST CHECK & WING RAILS shows the adjustment menu for the check & wing rails 

Adjustments can be made either by direct measurement 
data inputs, or by MOUSE ACTION 

SHIFT+CTRL + F10 MOVE PAGE ORIGIN MOUSE ACTION moves the printed page 

margins to fit the drawing 

SHIFT+CTRL + F11 FULL MOUSE DRAW (SLOW) show complete control template during mouse actions 

SHIFT+CTRL + F12 SKELETON MOUSE DRAW (FAST) show skeleton control template during mouse actions 

   

NUMPAD 2,4,6,8 keys MOVE MOUSE POINTER SQUARE use the number-pad keys instead of the mouse 

for mouse actions (square moves) 

NUMPAD 1,3,7,9 keys MOVE MOUSE POINTER DIAGONAL use the number-pad keys instead of the mouse 

for mouse actions (diagonal moves) 

NUMPAD 5 key CLICK MOUSE make a mouse click with the key instead of the 

mouse button 

   

CTRL +  \ RESET NOTCH ON GRID ORIGIN resets the notch onto the grid origin of the pad 

CTRL +  -  (minus key) SHORTEN BY ONE SLEEPER shorten the length of approach track or plain 

track by one sleeper ( CTRL + minus key) 
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CTRL +  = EXTEND TO NEXT SLEEPER extend the length of approach track or plain 

track by one sleeper ( CTRL + equal key) 

CTRL +  / SNAP EXIT TRACK TO SLEEPER snap the length of exit track to the centre of the 

end sleeper 

CTRL +  [ SHORTEN EXIT BY ONE SLEEPER shorten the length of exit track by one sleeper 

CTRL +  ] EXTEND EXIT TO NEXT SLEEPER extend the length of exit track by one sleeper 

CTRL +  `  (top left key) SNAP TURNOUT LENGTH TO VEE JOINT snap the turnout length to the end of the vee 

point rail (TVJP) ( CTRL + ` (top left) key) 

SHIFT+CTRL +  `  (top left key) SNAP TO PEG snap the length of the template to the control 

peg position (SHIFT+CTRL + ` (top left) key) 

   

CTRL +  .  (full-stop, period 
key) 

CROSS-HAIRS MOUSE POINTER change the mouse pointer to cross-hairs for 

accurate measuring and location 

( CTRL + full-stop, period key) 

   

ADD key ZOOM IN (SPOT EXPLODE) zoom in one normal step ( number-pad + key ) 

SUBTRACT key ZOOM OUT (SPOT SHRINK) zoom out one normal step ( number-pad - key ) 

CTRL + ADD ZOOM IN SLOW zoom in one small step ( CTRL+ number-pad + key ) 

CTRL + SUBTRACT ZOOM OUT SLOW zoom out one small step ( CTRL+ number-pad - key ) 

MULTIPLY key SHIFT PEG ONTO NOTCH shift the control template to engage its fixing 

peg on the notch ( number-pad * key ) 

DIVIDE key MOVE NOTCH UNDER PEG move the pegging notch under the control 

template's fixing peg ( number-pad / key ) 

SHIFT+CTRL+ = ZOOM IN same as ADD key above (Shift+Ctrl+equals key) 

SHIFT+CTRL+ -  (minus key) ZOOM OUT same as SUBTRACT key above 

(Shift+Ctrl+minus key) 

SHIFT+CTRL+ '  (quote key) SHIFT PEG ONTO NOTCH same as MULTIPLY key above 

(Shift+Ctrl+quote key) 

SHIFT+CTRL+ / MOVE NOTCH UNDER PEG same as DIVIDE key above 

(Shift+Ctrl+forward slash key) 

   

DECIMAL key PAD VIEW CENTRED ON PEG same as SHIFT + F9 above ( number-pad . key ) 

CTRL + DECIMAL key PAD VIEW CENTRED ON NOTCH centralize the pad view on the pegging notch 

 (CTRL + number-pad . key ) 

NUMPAD 0 key EXAMINE PEG (toggle) centralize the pad view on the fixing peg and 

zoom in close (toggle to zoom back out) 

   

INSERT key STORE & BACKGROUND add a copy of the control template to the 

storage box and copy it to the pad background 

(same as CTRL + V above) 

CTRL + INSERT OFF-SCREEN REFRESH select off-screen refresh mode (slow) 

SHIFT + INSERT ON-SCREEN REFRESH select on-screen refresh mode (fast) 

   

PAGE UP key ZOOM TO FIT ALL BACKGROUND TEMPLATES zoom to fit the background template onto the screen 
view 

PAGE DOWN key ZOOM TO FIT ALL GROUPED TEMPLATES zoom to fit the grouped template onto the screen view 

CTRL + PAGE UP LENGTH-FREE MODE template length changes with turnout size 

CTRL + PAGE DOWN LENGTH-LOCKED MODE template length is fixed regardless of turnout size 

   

CTRL + NUMPAD 0 PEG MOVES FREE moving the fixing peg with the CTRL + F8 

MOVE PEG mouse action will be free of 

constraints 

CTRL + NUMPAD 1 PEG ON RUNNING RAIL 1 (MS) the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along rail 1 
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CTRL + NUMPAD 2 PEG ON TURNOUT-ROAD CROSSING RAIL 2 the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along rail 2 

CTRL + NUMPAD 3 PEG ON MAIN-ROAD CROSSING RAIL 3 the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along rail 3 

CTRL + NUMPAD 4 PEG ON RUNNING  RAIL 4 (TS) the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along rail 4 

CTRL + NUMPAD 5 PEG ON ADJACENT TRACK-CENTRE MS the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along the adjacent track 

(main-side) centre-line 

CTRL + NUMPAD 6 PEG ON ADJACENT TRACK-CENTRE TS the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along the adjacent track 

(turnout-side) centre-line 

CTRL + NUMPAD 7 PEG ON DOUBLE TRACK CENTRE TS the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along the double-track 

(turnout-side) centre-line 

CTRL + NUMPAD 8 PEG ON MS-CENTRE the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along the main-road 

centre-line 

CTRL + NUMPAD 9 PEG ON TS-CENTRE the CTRL + F8 MOVE PEG mouse action will 

move the fixing peg along the turnout-road 

centre-line 

   

@ Key EXTRA-FINE ADJUST set extra-fine mouse action response rate 

% Key FINE ADJUST set fine mouse action response rate 

! Key COARSE ADJUST set coarse mouse action response rate 

   

< Key PAPER BUNCHING ON turn paper-bunching on 

> Key PAPER BUNCHING OFF reset paper-bunching off 

   

- Key (minus key) 1st TRANSITION RADIUS same as SHIFT+CTRL + F1 above 

= Key (equal key) 2nd TRANSITION RADIUS same as SHIFT+CTRL + F2 above 

[ Key ADJUST TRANSITION START same as SHIFT+CTRL + F3 above 

] Key ADJUST TRANSITION LENGTH same as SHIFT+CTRL + F4 above 

' Key (quote key) ADJUST SLEWING START same as SHIFT+CTRL + F5 above 

# Key (hash key) ADJUST SLEWING LENGTH same as SHIFT+CTRL + F6 above 

\ Key (back slash key) SHIFT GROUP same as SHIFT+CTRL + F7 above 

/ Key (forward slash key) ROTATE GROUP same as SHIFT+CTRL + F8 above 

   

DELETE key HIDE MOUSE ACTION PANEL (toggle) hide the mouse action panel without cancelling 

the mouse action (toggle) 

; Key (semi-colon key) TOGGLE MOUSE DRAW toggles SHIFT+CTRL  + F11 or  + F12 above 

. Key (full stop, period key) MOVE SPACING-RING MOUSE ACTION moves the spacing-ring tool 

(same as SHIFT+CTRL + F9) 

` Key (top-left key) PAD VIEW TO FIT BACKGROUND same as SHIFT + F12 above 

, Key (comma key) SHOVE TIMBERS same as SHIFT + F10 above 

   

 
 
 

SHIFT key or CAPS-LOCK key : If the Shift key is held down, or the Caps Lock is ON, background templates will be highlighted as the mouse 
pointer passes over their name labels, and a click on the label will show the pop-up menu for the template. The pop-up menu is also available by 
clicking anywhere on the template. 

The number-pad shortcuts will work only if NUMLOCK is ON and properly initialised. This may require NUMLOCK to be pressed OFF and then ON 
again. (This is a feature of some Windows Accessibility functions, not Templot). 

If you use the Windows Accessibility MouseKeys function it should be set to apply when NUMLOCK is OFF, otherwise the number-pad shortcuts will 
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not work. To change the setting click Start > Settings > Control Panel > Accessibility Options > Mouse > Settings. A function similar to 
MouseKeys is available within Templot (when NUMLOCK is ON) for use with the mouse actions, as shown in the list. 

This list contains only the drawing pad menu items for which there is a keyboard shortcut. There are many other menu items not listed here. The 
control room and storage box windows each have their own menus and a different set of shortcuts. 

To print this list click File > Print in this window. If the list does not fit within the page width click View > Text Size in this window and select a 
smaller size, or Ctrl-Roll (Ctrl+ mouse roller). 

This list can also be printed in a different format from within the Templot program. Click the help > show shortcut keys list menu item, and then 
click the print button. 

 
 


